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ВВЕДЕНИЕ
Рабочая программа учебной дисциплины разработана в соответствии с ФГОС СПО по специальности 42.02.01 Реклама.
Основная цель методических указаний по дисциплине «Разработка и размещение рекламного контента для продвижения торговой марки»
 - рассмотрение вопросов теории и методологии визуальных сообщений, и основных креативных решений творческих материалов на основных рекламных носителях.
Процесс изучения дисциплины направлен на формирование следующих компетенций в соответствии с ФГОС СПО по данной специальности, а также личностных результатов:
Перечень общих компетенций
ОК 1. Выбирать способы решения задач профессиональной деятельности применительно к различным контекстам
ОК 2. Использовать современные средства поиска, анализа и интерпретации информации, и информационные технологии для выполнения задач профессиональной деятельности
ОК 3. Планировать и реализовывать собственное профессиональное и личностное развитие, предпринимательскую деятельность в профессиональной сфере, использовать знания по финансовой грамотности в различных жизненных ситуациях.
ОК 4. Эффективно взаимодействовать и работать в коллективе и команде
ОК 5. Осуществлять устную и письменную коммуникацию на государственном языке Российской Федерации с учетом особенностей социального и культурного контекста.
ОК 6. Проявлять гражданско-патриотическую позицию, демонстрировать осознанное поведение на основе традиционных общечеловеческих ценностей, в том числе с учетом гармонизации межнациональных и межрелигиозных отношений, применять стандарты антикоррупционного поведения
ОК 9. Пользоваться профессиональной документацией на государственном и иностранном языках
Перечень профессиональных компетенций
[bookmark: _Toc151972622][bookmark: _Toc151990867][bookmark: _Toc151991533]ПК 4.1. Разрабатывать творческие рекламные решения для достижения целей креативной стратегии рекламной/коммуникационной кампании
ПК 4.2. Разрабатывать творческие рекламные решение в целях тактического планирования рекламной коммуникационной компании
ПК 4.3. Проводить разработку и размещение рекламного контента для продвижения торговой марки/бренда/организации в сети Интернет
Перечень личностных результатов
ЛР 13 Выбирающий оптимальные способы решения профессиональных задач на основе уважения к заказчику, понимания его потребностей 
ЛР 17 Знающий порядок работы с локальными и глобальными телекоммуникационными системами, методы обработки информации с использованием современных технических средств коммуникации и связи
ЛР 18 Знающий и соблюдающий этические нормы поведения и основы делового имиджа Компании
ЛР 22 Вооруженный необходимыми профессиональными знаниями, выработавший умения и навыки трудовой деятельности, основ трудовой культуры 
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Радел 1. Основы компьютерной графики
Тема 1.1. Основы векторной графики. Программа Adobe Illustrator
Практическое занятие №1. Рисунок из геометрических объектов. Создание логотипа
В этом уроке мы будем рисовать геометрическое лого в Adobe Illustrator. Для начала мы сформируем основную форму — базу нашего будущего логотипа, затем придадим ему объем при помощи создания краев. После поработаем с многочисленными градиентами, отражениями и бликами, чтобы создать полноценный 3D-эффект. После изучения урока поэкспериментируйте, сделайте свой логотип или измените лого сделанное по уроку «Закрепите материал».
[image: https://puart.ru/images/jf/Statai/23/01.png]
1. Готовим документ
Шаг 1
Начнем с создания нового документа в Adobe Illustrator со следующими параметрами.
 [image: https://puart.ru/images/jf/Statai/23/02.png]
Шаг 2
Теперь давайте создадим сетку, 50x50px с четырьмя разделами. Preferences > Guides and grids / Редактирование — Направляющие, сетка и фрагменты, и укажите следующие параметры.
 [image: https://puart.ru/images/jf/Statai/23/03.png]
Шаг 3
Активируйте сетку (View > Show grid / Просмотр > Показать сетку) и включите опцию View > Snap to grid / Просмотр > Привязка к сетке.
 [image: https://puart.ru/images/jf/Statai/23/04.png]
2. Базовые фигуры для логотипа
В этом разделе мы нарисуем основную структуру логотипа — геометрические фигуры, которые потом будем раскрашивать и до оформлять.
Шаг 1
Нарисуйте в центре рабочей области круг без заливки размером 200x200px при помощи инструмента [image: https://puart.ru/images/jf/Photoshop-icon/49.png] Ellipse / Эллипс (L). Создайте еще один круг размером 100x100px внутри предыдущего.
 [image: https://puart.ru/images/jf/Statai/23/05.png]
Шаг 2
Нарисуйте еще один круг (150x150px), выровняйте его по центру с остальными двумя, затем подвиньте его вправо, двумя нажатиями на стрелку на клавиатуре.
Теперь нарисуйте два прямоугольника: первый размером 50x50px, а второй — 50x25pz и поместите их как показано на картинке ниже.
 
[image: https://puart.ru/images/jf/Statai/23/06.jpg]
Шаг 3
Выделите все фигуры, и инструментом [image: https://puart.ru/images/jf/Photoshop-icon/52.png] Shape Builder / Создание фигур (shift+M) мы объединим фигуры. Объедините фигуры, указанные ниже. Сейчас можете указать им любой цвет заливки, мы вернемся к этому вопросу позже.
Сотрите оставшиеся лишние фигуры.
 [image: https://puart.ru/images/jf/Statai/23/07.png]
Шаг 4
Скруглите нижние углы инструментом [image: https://puart.ru/images/jf/Photoshop-icon/47.png] Direct Selection / Прямое выделение (A) до тех пор, пока не получите арку. Уберите обводку с обеих фигур.
 [image: https://puart.ru/images/jf/Statai/23/08.png]
3. Рисуем кромку
У нас уже есть основная форма логотипа, но сейчас мы сделаем кромку, которая придаст объекту объема. Это будет просто, так как мы используем фигуру логотипа.
Шаг 1
Отключите опцию привязки к сетке и укажите 0.50px для параметра Keyboard Increment / Клавиатурный сдвиг. Вы найдете эту опцию в меню Preferences > General / Редактирование > Общее. Выделите левую часть арки и переместите ее на 10 нажатий клавиши влево. Затем пошлите эту фигуру на задний план (Object > Arrange > Send to back / Объект).
Дублируйте (Ctrl+C Crtl+F) другую часть арки и переместите ее на 10 нажатий вправо, затем пошлите на задний план. Инструментом [image: https://puart.ru/images/jf/Photoshop-icon/52.png] Shape Builder / Создание фигур (Shift+M) удалите лишнюю часть арки.
 [image: https://puart.ru/images/jf/Statai/23/09.png]
[image: https://puart.ru/images/jf/Statai/23/10.png]
Шаг 2
Выделите правую часть арки и переместите ее на 10 нажатий вправо, затем пошлите на задний план. Укажите ему более темный цвет, чтобы различать его рядом с основной фигурой.
 [image: https://puart.ru/images/jf/Statai/23/11.png]
4. Градиенты и прозрачность
Теперь у нас есть кромка, пришло время добавить немного магии при помощи градиентов и прозрачности слоев, чтобы получить эффект 3D.
Шаг 1
Примените линейный градиент (используйте инструмент [image: https://puart.ru/images/jf/Photoshop-icon/33.png] Gradient / Градиент (G) к левой части арки, и еще один к задней части логотипа. Другой градиент укажите краям логотипа.
 [image: https://puart.ru/images/jf/Statai/23/12.png]
Шаг 2
Выделите верхнюю часть логотипа, дублируйте ее (Ctrl+C Ctrl+F) и укажите ей заливку желтого цвета. Дублируйте еще раз и залейте фигуру красным.
Инструментом [image: https://puart.ru/images/jf/Photoshop-icon/47.png] Direct Selection / Прямое выделение (A) выделите нижнюю точку арки и переместите ее вверх одним нажатием стрелки вверх. Выделите красную и желтую фигуры и нажмите на иконку Minus Front / Минус верхний в палитре Pathfinder / Обработка контура.
 [image: https://puart.ru/images/jf/Statai/23/13.jpg]
Шаг 3
Повторите эту процедуру с той же частью арки, с кромкой, чтобы добиться эффекта скошенных краев.
 [image: https://puart.ru/images/jf/Statai/23/14.png]
[image: https://puart.ru/images/jf/Statai/23/15.jpg]
Шаг 4
Залейте скосы прозрачным градиентом. Все цвета градиента будут белыми, но вот прозрачность разная. Повторите настройте как на картинке ниже.
Растяните градиент по всему скосу.
 [image: https://puart.ru/images/jf/Statai/23/16.jpg]
5. Отражения и прозрачность
Наш логотип начинает выглядеть реалистичнее. Давайте добавим еще немного реалистичности при помощи отражений и бликов.
Шаг 1
Дублируйте верхнюю часть логотипа два раза, и укажите фигурам желтую и красную заливки.
Переместите верхнюю фигуру на 3 движения влево, удерживая Shift. Выделите обе фигуры и кликните на Minus Front / Минус верхний в палитре Pathfinder / Обработка контура.
Инструментом [image: https://puart.ru/images/jf/Photoshop-icon/33.png] Gradient / Градиент (G) укажите градиент от белого цвета на 50% opacity / непрозрачности к белому на 0% opacity / непрозрачности.
 [image: https://puart.ru/images/jf/Statai/23/17.jpg]
Шаг 2
Создайте блик для верхней и нижней части лого тем же способом, что был описан выше.
 [image: https://puart.ru/images/jf/Statai/23/18.jpg]
Шаг 3
Дублируйте верхнюю часть лого еще один раз, и инструментом [image: https://puart.ru/images/jf/Photoshop-icon/38.png] Pen / Перо (P) нарисуйте поверх фигуры пересекающую ее кривую.
Выделите кривую и фигуру и нажмите Divide / Разделить в палитре Pathfinder / Обработка контура. Разгруппируйте объекты (Object > Ungroup) и удалите лишнее. Укажите фигуре белый градиент на 50% opacity / непрозрачность.
 [image: https://puart.ru/images/jf/Statai/23/19.png]
Шаг 4
Дублируйте фигуру из прошлого шага два раза и залейте копии желтым и красным цветами. Инструментом [image: https://puart.ru/images/jf/Photoshop-icon/38.png] Pen / Перо (P) создайте дополнительную опорную точку в указанном на картинке ниже месте и подвиньте ее вверх.
Используйте опцию Minus Front / Минус верхний чтобы создать блик. Залейте его белым цветом на 50% opacity / непрозрачность.
 [image: https://puart.ru/images/jf/Statai/23/20.jpg]
Шаг 5
Повторите указанные ниже шаги, чтобы добавить еще одно отражение на верхней и нижней частях лого.
 [image: https://puart.ru/images/jf/Statai/23/21.jpg]
6. Финальные штрихи
Шаг 1
Выделите весь логотип и сгруппируйте его (Ctrl+G). Дублируйте группу (Ctrl+F) и отразите копию вертикально и горизонтально (Object > Transform > Reflect / Объект > Трансформировать > Отразить) и расположите две группы как показано ниже. Сгруппируйте все вместе.
 
[image: https://puart.ru/images/jf/Statai/23/22.jpg]
Шаг 2
Теперь создадим фон инструментом [image: https://puart.ru/images/jf/Photoshop-icon/46.png] Rectangle / прямоугольник (M). Нарисуйте прямоугольник по размеру холста (800x600px), и укажите ему темно-синий цвет заливки. Поместите прямоугольник на задний план и выровняйте его и лого по центрам.
 
[image: https://puart.ru/images/jf/Statai/23/23.jpg]
 Практическое занятие №2. Работы с кривыми. Кисти. Создание текстурных векторных кистей
1. Берем инструмент Elipse и создаем круг размером 1 на 1 пиксель.
[image: Создаем текстуру - кисть]
Создаем текстуру — кисть
2. Перетаскиваем фигуру круга на панель Brushes. В первом появившемся окне выбираем пункт Scatter Brush и жмем ОК. В следующем окне вводим параметры как показано на рисунке ниже и жмем ОК. В результате этого на панели Brushes должна появиться новая кисть.
[image: https://vecart.ru/wp-content/uploads/2012/06/bad75124eb-e1648994070287.jpg]

3. На панели Brushes берем созданную кисть и копируем ее, просто перетащив на кнопку создания новой кисти     В результате этого на панели появится копия нашей кисти. Делаем двойной щелчок мыши на ней. В появившемся окне изменяем параметры Spacing и Scater как показано на рисунке ниже.
[image: Создаем текстуру - кисть]
Создаем текстуру — кисть
4. Повторяем действия, описанные в предыдущем пункте. Изменяем те же параметры кисти.
В результате у нас должно получится три новых кисти на панели Brushes (оригинал, первая копия и вторая копия).
[image: Создаем текстуру - кисть]
Создаем текстуру — кисть
5. На этом этапе нам нужно создать новый графический стиль. Для этого берем инструмент Перо (Pen), Карандаш (Pensil) или Кисть (Brush) и чертим линию.
При выделенной линии на панели Brushes щелкаем на нашей первой кисти (оригинал), тем самым придавая линии ее свойства.
Теперь переходим на панель Appearance и копируем контур (тащим имеющийся контур на кнопку создания нового). Новому контуру придаем свойства второй нашей кисти (первая копия), выбрав ее из выпадающего меню.
Повторяем вышеописанные действия и добавляем еще один контур со свойствами нашей третьей кисти (вторая копия).
В результате имеем линию с тремя контурами, свойства которых задают наши кисти.
[image: Создаем текстуру - кисть]
Создаем текстуру — кисть
Получившуюся линию перетаскиваем на панель Graphic Styles, тем самым создавая новый стиль.
[image: Создаем текстуру - кисть]
Создаем текстуру — кисть
6. Текстура создана. Перейдем непосредственно к её использованию.
Рисуем необходимые нам линии и придаем им свойства нашего нового графического стиля, кликнув на соответствующем значке панели Graphic Styles.
Далее на панели Appearance изменяем цвет контуров, используя выпадающую палитру.
У меня получилось следующее.
[image: Создаем текстуру - кисть]

Практическое занятие №3. Векторный компьютерный рисунок с использованием кривых. Создание паттерна
Создадим монтажную область размером 2000×2000 px. Такое разрешение в 4 Мп требуется на некоторых фотостоках.
[image: http://inetvinegret.ru/wp-content/uploads/2019/12/%D1%81%D0%BE%D0%B7%D0%B4%D0%B0%D0%BD%D0%B8%D0%B5-%D0%BE%D0%B1%D0%BB%D0%B0%D1%81%D1%82%D0%B8.jpg]
Для будущего паттерна я нарисовала вот такую бабочку.
[image: http://inetvinegret.ru/wp-content/uploads/2019/12/%D1%83%D0%B7%D0%BE%D1%801.jpg]
Затем, используя клавиши выделения и копирования, добавила еще тройку таких же бабочек на область и методом заливки покрасила их в разные цвета.
[image: http://inetvinegret.ru/wp-content/uploads/2019/12/%D1%83%D0%B7%D0%BE%D1%802.jpg]
Далее, нам нужно расположить бабочек так, чтобы они равномерно распределились в верхнем левом углу монтажной области и выступали за ее пределы.
[image: http://inetvinegret.ru/wp-content/uploads/2019/12/%D1%83%D0%B7%D0%BE%D1%803JPG.jpg]
Выделяем слева все то, что выходит за пределы области, нажимаем «Трансформирование»-«Перемещение».
[image: http://inetvinegret.ru/wp-content/uploads/2019/12/%D1%83%D0%B7%D0%BE%D1%804JPG.jpg]
[image: http://inetvinegret.ru/wp-content/uploads/2019/12/%D1%83%D0%B7%D0%BE%D1%805.jpg]
Вводим значение по горизонтали равное ширине нашей монтажной области 2000 px, по вертикали ставим 0 и нажимаем копировать. Появляется такая же бабочка с противоположной стороны.
[image: http://inetvinegret.ru/wp-content/uploads/2019/12/%D1%83%D0%B7%D0%BE%D1%806.jpg]
 То же самое проделываем  с элементами, выходящими за область сверху. Получим следующее.
[image: http://inetvinegret.ru/wp-content/uploads/2019/12/%D1%83%D0%B7%D0%BE%D1%807.jpg]
Теперь подкорректируем изображение, заполняя пустующие зоны, раскрашивая дополнительные элементы.
[image: http://inetvinegret.ru/wp-content/uploads/2019/12/%D1%83%D0%B7%D0%BE%D1%808.jpg]
Методы создания паттерна
Обрезать все, что выходит за пределы паттерна, можно несколькими способами:
· использование пустой рамки по краям тайла;
· обрезка;
· разделение;
· функция «создать шаблон».
Первый способ можно назвать самым легким и используемым в работе иллюстраторов, но его не принимают фотостоки. Необходимо создать квадрат без заливки и контура точно такого же размера, как монтажная область и поместить его на задний план. Затем все выделить и перетащить в панель «Образцы». После этого можно выполнять заливку любого объекта, используя этот образец. Пустой квадрат будет задавать границы нашего тайла, но не будет обрезать лишнее, а только скрывать.
[image: http://inetvinegret.ru/wp-content/uploads/2019/12/%D1%83%D0%B7%D0%BE%D1%8010JPG.jpg]
[image: http://inetvinegret.ru/wp-content/uploads/2019/12/%D1%83%D0%B7%D0%BE%D1%809.jpg]
Во втором способе мы будем совершать похожие действия. Берем квадрат одинакового размера с областью и помещаем его на наш рисунок. Далее все выделяем и нажимаем «Обрезка». Получим требуемый паттерн. В данном случае минусом будет образование нарезок элементов.
[image: http://inetvinegret.ru/wp-content/uploads/2019/12/%D1%83%D0%B7%D0%BE%D1%8011.jpg]
Третий способ является сложным, но считается более профессиональным. Квадрат, созданный по аналогии с двумя предыдущими методами, помещаем сверху изображения, выделяем его и отделяем при помощи функций «Объект»-«Контур»-«Разделить нижние объекты».
[image: http://inetvinegret.ru/wp-content/uploads/2019/12/%D1%83%D0%B7%D0%BE%D1%8012PG.jpg]
Затем следует разгруппировать изображение и удалить лишние детали, выходящие за монтажную область. Делать это нужно особо тщательно, так как не удаленные элементы будут искажать и мешать созданию правильного шаблона узора.
[image: http://inetvinegret.ru/wp-content/uploads/2019/12/%D1%83%D0%B7%D0%BE%D1%8013JPG.jpg]
После удаления снова группируем все и добавляем узор в панель с образцами. Созданный паттерн этим способом можно смело размещать на фотостоках, например на Shutterstock.
Четвертый способ намного облегчил работу дизайнеров и отлично работает в версиях Adobe Illustrator CS6 и выше.  На монтажную область помещается нужный элемент, а затем при помощи функции «Узор»-«Создать» получаем заготовку будущего паттерна. 
[image: http://inetvinegret.ru/wp-content/uploads/2019/12/%D1%83%D0%B7%D0%BE%D1%8014JPG.jpg]
Здесь возможно корректировать элементы: цвет, форму, размер, расположение.
Подобрав желаемые параметры к изображению, нажимаем готово, и наш узор автоматически отправляется в образцы. Теперь мы можем делать заливки разных объектов.
[image: http://inetvinegret.ru/wp-content/uploads/2019/12/%D1%83%D0%B7%D0%BE%D1%8015.jpg]
Данные способы создания шаблона очень просты. Готовые паттерны не образуют швов и могут использоваться для создания бесконечных фонов

Практическое занятие №4. Создание рекламного плаката. Работа с текстом. 
Шаг 1
Прежде чем мы начнем, возможно вы захотите загрузить материалы, которые мы будем использовать, чтобы создать нашу работу. Они все бесплатные и вы можете загрузить их по ссылкам ниже:
Так же, не забудьте загрузить графику, которая прилагается к этому уроку (вы должны видеть кнопку Download Attachment справа). Внутри файла, вы найдете несколько декоративных элементов, которые я создала чтобы ускорить процесс, и мы могли больше сосредоточиться в этом проекте на типографике.
Шаг 2
[image: https://cms-assets.tutsplus.com/uploads/users/1129/posts/24957/image/oz-type-open-document.png]
Дальше, мы создадим задний фон, который поможет нам правильно расположить надписи. В начале мы будем использовать элементы черного цвета, а цвет мы добавим позже.
Шаг 3
Поместите рисунок рубиновой туфельки (из скачанного вами файла) и измените ее размер( пропорционально, для чего удерживайте нажатым Shift), чтобы она заполняла почти весь нижний угол страницы. Используйте инстурмент инструмент Эллипс (L) (Ellipse Tool), что бы нарисовать окружность, почти нав всю ширину страницы (у меня оружность 530 рх в диаметре). Расположите ее так, что бы она пересекала туфельку, ниже бантика (на туфельке).
[image: https://cms-assets.tutsplus.com/uploads/users/1129/posts/24957/image/oz-type-background-graphics-1.png]
Шаг 4
Поставьте толщину обводки окружности на 10 pt. Видите то, место, где окружность пересекает туфельку, «разрезая» белую линию около ленточки? Возьмите инструмент Стирание Контура (Path Eraser Tool) (вы найдете его под иконкой Карандаша; нажмите и подержите нажатой кнопку мыши, и через секунду появится выпадающее меню) и убедившись, что окружность у вас выделена, сотрите ту ее часть которая накладывается на белый фрагмент.
[image: https://cms-assets.tutsplus.com/uploads/users/1129/posts/24957/image/oz-type-path-eraser.png]
3. Размещаем Типографику
Перед тем как мы начнем эту часть, убедитесь, что вы скачали и установили все шрифты, которые мы будем использовать (ссылки на них были выше в разделе «Предварительная Подготовка»).
Шаг 1
Сперва, напечатайте отдельно заглавную H, так как она будет иметь другой шрифт, нежели остальная часть слова. Мы используем шрифт Harrington, размером 305 рt. Поместите ее в нижней левой части окружности. Затем напечатайте OME все заглавными буквами на этот раз используйте шрифт akaPosse, меньшего размера 128 pt.
[image: https://cms-assets.tutsplus.com/uploads/users/1129/posts/24957/image/oz-type-home.png]
Шаг 2
Теперь мы собираемся добавить эффект деформации для OME, что бы форма соответствовала наклонному очертанию туфельки. Зайдите в Эффект > Деформация > Подъем (Effect > Warp > Rise) и установите Изгиб (Bend) на 36%.
[image: https://cms-assets.tutsplus.com/uploads/users/1129/posts/24957/image/oz-type-warp-text.png]
Шаг 3
Откройте меню Символ (Character) и поставьте величину для Трекинга 75, что бы сделать побольше расстояние между буквами. После того, как вы это сделаете, возможно, надпись HOME, не будет выглядеть выровненной по окружности, но это нормально, потому что у нас впереди еще пара настроек.
[image: https://cms-assets.tutsplus.com/uploads/users/1129/posts/24957/image/oz-type-set-tracking.png]
Шаг 4
Буква Н кажется тонковатой по сравнению со следующей частью слова ОМЕ, поэтому сделаем ее потолще, добавив обоводку толщиной в 7рt, тем же способом, как мы настраивали обводку у окружности раньше.
Теперь, по мне, так Н выглядит слишком широко, поэтому я ее выделяю и потяну за одну из средних маркеров трансформации в сторону, что бы сделать ее чуть тоньше. Теперь я могу сдвинуть Н немного вниз, что бы нижний угол окружности смотрелся получше. Так же как мы только что делали, я выделяют ОМЕ, и используя угловой маркер трансформации, поверну надпись немного против часовой стрелки, так что бы О опустилось и заполнило угол, образовавшийся между Н и туфелькой. После того, как вы все сделаете, у вас должно получиться что-то вроде этого:
[image: https://cms-assets.tutsplus.com/uploads/users/1129/posts/24957/image/oz-type-position-text.png]
Шаг 5
Напечатайте like нижним регистром использовав шрифт Smythe размером 110 pt.
Теперь деформируйте текст, как мы делали для OME, зайдите в Эффект > Деформация > Подъем (Effect > Warp > Rise) и установите Изгиб (Bend) на 30%.
[image: https://cms-assets.tutsplus.com/uploads/users/1129/posts/24957/image/oz-type-warp-text-2.png]
Разместите надпись внизу угла, образованного HOME, оставив примерно такое же расстояние по вертикали между like и OME, как между OME и туфелькой.
Шаг 6
Напечатайте заглавную Р используя шрифт Fletcher Gothic размером 200 рt. И добавьте обводку толщиной 8pt. Расположите Р так, что бы ее засечка внизу, выровнялась по диагонали с Н, как показано на рисунке.
Напечатайте LACE заглавными буквами, используя akaPosse размером 110 pt.
Примените к LACE эффект деформации (снова используйте Эффект > Деформация > Подъем), установив для Изгиба 57%. Но пока не жмите ОК&в этот раз, мы настроим другой параметры деформации, Горизонтальное Искажение. Благодаря этому буквы будут немного увеличиваться, если смотреть слева на право. Установите для этого параметра значение 25%.
[image: https://cms-assets.tutsplus.com/uploads/users/1129/posts/24957/image/oz-type-warp-distort-text.png]
Шаг 7
Напечатайте no нижним регистром, используя шрифт Smythe размером 75pt.
В этот раз, вместо того, чтобы деформировать слово, мы повернем его и добавим наклон, что сделает шрифт похожий на курсивный.
Сперва, поверните «no» против часовой стрелки, примерно так же как LACE. Затем выберите Объект > Трансформировать > Наклон (Object > Transform > Shear) и напечатайте 20 для Угла Наклона.
[image: https://cms-assets.tutsplus.com/uploads/users/1129/posts/24957/image/oz-type-shear.png]
Расположите no примерно по центру пустого пространства, оставшегося вверху окружности. Позднее мы добавим декоративных элементов.
Шаг 8
Мы собираемся поместить Theres в верхний угол страницы, используя наклон и эффекты деформации, что бы он изгибался по кривой окружности.
Напечатайте заглавную Т используя Fletcher Gothic размером 205 pt.
Заметьте что Т имеет на конце изогнутый хвостик? Мы хотим что бы изгиб этой кривой, соответствовал кривой окружности, поэтому мы наклоним его, как мы делали с no.
Сначала, поверните Т против часовой стрелки, так что бы нижняя кривая выровнялась по сегменту окружности. Теперь выберите Объект > Трансформировать > Наклон (Object > Transform > Shear) и введите 30 для Угла Наклона. Это немного выпрямит Т назад, а нижнюю часть оставит в том же положении.
[image: https://cms-assets.tutsplus.com/uploads/users/1129/posts/24957/image/oz-type-shear-2.png]
Шаг 9
Поместите T туда, где кривая в нижней части, будет хорошо соответствовать изгибу окружности. Поверните немного или отрегулируйте длину, что бы улучшить соответствие на ваш вкус.
Напечатайте heres используя шрифт Smythe размером 110 pt. Поверните против часовой стрелки, что бы хорошо помещалось между T и окружностью.
Шаг 10
Выберите Объект > Трансформировать > Наклон (Object > Transform > Shear) и введите 15 для Угла Наклона.
[image: https://cms-assets.tutsplus.com/uploads/users/1129/posts/24957/image/oz-type-shear-text-2.png]
Шаг 11
Выберите Эффект > Деформация > Дуга Вниз (Effect > Warp > Arc Lower) и поставьте для Изгиба величину -30%.
[image: https://cms-assets.tutsplus.com/uploads/users/1129/posts/24957/image/oz-type-warp-arc-lower.png]
И вот что в итоге должно у нас получиться:
[image: https://cms-assets.tutsplus.com/uploads/users/1129/posts/24957/image/oz-type-typsetting-results.png]
4. Добавим Цвет
Если вы всеже захотите использовать эту цветовую схему, ниже вы найдете hex-кодировку для цветов, которые вы можете вставить в окно Палитры Цветов (просто выберите объект которому вы хотите назначить цвет, дважды щелкните по квадрату Заливки внизу слева на панели инструментов; в новом окне, которое откроется, введите код в окошко перед которым стоит знак #). Как только вы это сделаете, вы можете перетащить цвет с квадрата Заливки в Панель Образцов (Swatches), что бы вам было легче его использовать.
[image: https://cms-assets.tutsplus.com/uploads/users/1129/posts/24957/image/oz-type-color-palette-2.png]
Шаг 1
Сперва выберите все что у вас есть на странице для этого нажмите (Command/Control-A) и выберите Текст > Преобразовать в Кривые (Type > Create Outlines). Пока все выбрано зайдите в Объект > Разобрать Оформление (Object > Expand Appearance).
[image: https://cms-assets.tutsplus.com/uploads/users/1129/posts/24957/image/oz-type-expand.png]
Шаг 2
Теперь зайдите в Окно > Панель Преобразования Контуров (Window > Pathfinder), и в появившемся окне выберите Соединение (Unite) (первая кнопка в верхней строке). В результате этого, все три объекта у нас объединяться в одну группу, но нам этого не надо, поэтому зайдите в Объект > Разгруппировать (Object > Ungroup).
[image: https://cms-assets.tutsplus.com/uploads/users/1129/posts/24957/image/oz-type-pathfinder-unite.png]
Шаг 3
5. Наносим Последние Штрихи: Текстура и Другие Декоративные Элементы
Мы собираемся добавить несколько различных текстур, что бы придать нашему дизайну, вид старинной, напечатанной чернильными красками, работы.
Шаг 1
Выберите все на странице. Зайдите в Эффект > Исказить и Трансформировать > Огрубление (Effect > Distort & Transform > Roughen). Поэкспериментируйте с настройками, пока вам не понравится эффект. После того нажмите ОК, и если вы захотите попробовать другие настройки, вы можете отрегулировать их зайдя в меню Окно > Оформление (Window > Appearance) и и щелкнув по Огрублению, в результате чего снова откроется окно. Вы можете видеть установки которые выбрала я, на скриншоте ниже:
[image: https://cms-assets.tutsplus.com/uploads/users/1129/posts/24957/image/oz-type-roughen-effect.png]
Шаг 2
[image: https://cms-assets.tutsplus.com/uploads/users/1129/posts/24957/image/oz-type-embellishments.png]
Если вы захотите нарисовать, свои декоративные элементы, что бы заполнить пустые места, сделайте это!
Шаг 3
Если вы еще не загрузили этот бесплатный набор текстур, сделайте это. Внутри будет три файла Иллюстратора (AI). Мы будем использовать файлы с названием texture 1 и texture 2.
Создайте новый слой и поместите в него одну из текстур (Файл > Поместить и найдите файл на вашем компьютере). У вас появится окно с текстурой; нажмите ОК.
[image: https://cms-assets.tutsplus.com/uploads/users/1129/posts/24957/image/oz-type-edit-texture-content.png]
Шаг 4
Теперь поверните текстуру на угол 90 градусов. (Объект > Трансформировать > Поворот; Введите угол 90 градусов и нажмите Ввод/Enter). Текстура того же размера, что и документ, так что просто разместите ее по центру страницы.
Повторите все тоже самое для второй текстуры. Когда вы закончите, заблокируйте слой с текстурами. У вас будет приятная зернистость, которая выглядит следующим образом:
[image: https://cms-assets.tutsplus.com/uploads/users/1129/posts/24957/image/oz-type-inner-texture.png]
Шаг 5
Теперь, мы собираемся вернуть часть структуры букв назад, там где у нас «сильная» текстура, добавив внутреннюю обводку для слов PLACE и HOME, чтобы смягчить зернистость.
Выберите PLACE и HOME копируйте их (Command/Control-C). Вставьте их в новый слой используя Редактирование > Вставить на Передний План (Command/Control-F). Это пока будет выглядеть так,
как будто вы накрыли текстуру.
Пока выделены слова, кликните по стрелочке Переключателю Обводки и Заливки (Shift-X)
[image: https://cms-assets.tutsplus.com/uploads/users/1129/posts/24957/image/oz-type-inner-stroke.png]
Шаг 6
[image: https://cms-assets.tutsplus.com/uploads/users/1129/posts/24957/image/oz-type-inner-stroke2.png]
Шаг 7
Мы собираемся воссоздать эффект параллельного текста, который мы видели в первой картинке, которой мы вдохновлялись (Lion Coffee). Обратите внимание на эту отличную комбинацию пустого пространства и тени, которая идет от буков слова Lion? Мы используем этот эффект.
Создайте новый слой, и сместите его вниз, что бы он был вторым слоем (прямо над слоем с бежевым фоном).
Копируйте HOME и Вставьте На Задний План (Command/Control-B) вашего слоя. Измените цвет на лавандовый-серый/ #8A6E78 и используйте кнопки стрелок, что бы сместить надпись вниз и вправо от основных букв, так, чтобы это выглядело как тень.
[image: https://cms-assets.tutsplus.com/uploads/users/1129/posts/24957/image/oz-type-offset-effect-1.png]
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Шаг 8
Мы почти все сделали! Последним завершающим штрихом, который придаст нашему дизайну по-настоящему винтажный вид добавление поверх текстуры старой бумаги. В Иллюстраторе есть, режимы наложения, как и в Photoshop, поэтому нам даже не надо переключаться на другую программу.
Если вы еще не загрузили текстуру бумаги сделайте это. Поместите ее в новый слой (убедитесь, что этот слой расположен поверх всех), и сделайте ее размером со всю страницу.
Выбрав эту текстуру, откройте панель Прозрачность (Transparency) и (Окно > Прозрачность). Выберите Рассеянный Свет (Soft Light) в выпадающем меню и оставьте непрозрачность 100%.
[image: https://cms-assets.tutsplus.com/uploads/users/1129/posts/24957/image/oz-type-paper-texture.png]
Дублируйте текстуру бумаги, скопировав и вставив ее на поверх того, что у вас уже есть. В этот раз, измените установки прозрачности на Зам. Темн. (Darken) и непрозрачность поставьте на 25%.
[image: https://cms-assets.tutsplus.com/uploads/users/1129/posts/24957/image/oz-type-final-product.jpg]




Тема 1.2. Основы растровой графики. Программа Photoshop
Практическое занятие №1. Создание композиции с использованием готовых выделенных объектов.
Создание многослойной монтажной композиции в растровой графике
Для начала проанализируйте свою идею. Искусство – это как школьный проект. Чтобы максимально эффективно воплотить свой замысел, нужно проанализировать символы, цвета, свое окружение, которые необходимы для достижения реалистичного результата.
Все свои идеи и мысли можно записать на бумаге, в телефоне или даже на обычной салфетке в виде набора слов, которые максимально подробно опишут то, как вы себе представляете готовую работу.
Например, если вы хотите создать коллаж на тему Золушки, тогда можете записать следующие фразы:
· карета-тыква Золушки;
· яркий красный лес;
· мрачновато, но красиво;
· волшебные тыквы;
· центрированная композиция;
Этот небольшой набор слов вызывает в моей голове достаточно образов, чтобы соединить их в одну композицию. Обратите внимание, что я не только записала конкретные объекты, но и слова, описывающие настроение на картинке, а также цвета и особенности композиции.
[image:   Фотоманипуляция, коллажирование, фото-Арт – способы превращения фотографий во что-то новое и интересное.-3]
Каждый новый проект я начинаю с этих шагов. Это дает мне возможность понять, какие элементы должны быть на коллаже, а какие из них лишние. Если вам интересно, вот такой результат получился у меня, то смотрите урок Делаем в Фотошоп волшебный коллаж с каретой и тыквами.
[image:   Фотоманипуляция, коллажирование, фото-Арт – способы превращения фотографий во что-то новое и интересное.-4]
Маленькие наброски
Переходим к следующему этапу – наброски. Да-да, именно наброски! Но для этого вам не нужно быть экспертом в рисовании. Набросок можно изобразить в виде нескольких линий и простых фигур, так что любой новичок с этим справится.
Фотоманипуляция, по сути, – это пазл. Поэтому главная цель наброска – визуализировать расположение композиционных элементов. Закончив с этим, вы можете начать подбирать подходящие для коллажа картинки.
[image:   Фотоманипуляция, коллажирование, фото-Арт – способы превращения фотографий во что-то новое и интересное.-5]
Изобразите расположение элементов на маленьких набросках.
Кроме того, наброски дадут вам возможность поэкспериментировать с разными идеями перед тем, как приступить непосредственно к их реализации.
У вас могут возникнуть вопросы: «Должен ли основной объект находиться в центре? Или лучше справа?» Попробуйте разные варианты и посмотрите, какой из них наиболее удачный. Так вы сохраните время и силы на основной этап работы.
Для одной из последних работ со светлячками я набросала простенький рисунок, который вы видите на картинке ниже.
[image:   Фотоманипуляция, коллажирование, фото-Арт – способы превращения фотографий во что-то новое и интересное.-6]
Я всего лишь нарисовала контуры банок, несколько букашек и траву в виде линий. Это дало мне достаточно визуальных образов для создания финального результата.
В самом начале работайте с простыми композициями, которые вы знаете и понимаете! Например, обычный портрет по центру. Не усложняйте работу перспективой и сложными ракурсами.
Советы по созданию коллажей в Фотошоп
Фотоманипуляция, коллажирование, фото-Арт – способы превращения фотографий во что-то новое и интересное. Одни из нескольких картинок могут создать детализированный пейзаж, а другие разрабатывают персонажей из множества отдельных стоковых фото.
Но это удел профессионалов. А с чего же начать покорять фотоманипуляцию, если вы всего лишь новичок?
В этом уроке я поделюсь с вами полезными советами по созданию коллажей, которые пригодятся начинающим Фотошоп-мастерам. Я покажу вам, какие инструменты полезны в работе, а также раскрою базовые принципы «сшивания» разных фото в целостную композицию.
Перед началом учтите один важный момент! Творческий процесс – это путешествие. Многие, прочитав статью или урок, закрывают ее, полагая, что все усвоили.
Но только через эксперименты, практику, пробы и ошибки вы усвоите материал. Поэтому действуйте и не забудьте поделиться своими результатами!
От идеи к готовому коллажу
Любой рисунок начинается с идеи. Возможно, у вас в голове понарошку загорается лампочка, которая сигнализирует о начале творческого процесса.
Так из каких же этапов состоит процесс от идеи до реализации?
На самом деле, это зависит от самого художника. И, в зависимости от уровня ваших навыков, некоторые шаги можно пропустить. Но есть несколько важных ключевых моментов в этом процессе.
Записывайте свои идеи
Для начала проанализируйте свою идею. Чтобы максимально эффективно воплотить свой замысел, нужно проанализировать символы, цвета, свое окружение, которые необходимы для достижения реалистичного результата.
Все свои идеи и мысли можно записать на бумаге, в телефоне или даже на обычной салфетке в виде набора слов, которые максимально подробно опишут то, как вы себе представляете готовую работу.
Например, если вы хотите создать коллаж на тему Золушки, тогда можете записать следующие фразы:
· карета-тыква Золушки;
· яркий красный лес;
· мрачновато, но красиво;
· волшебные тыквы;
· центрированная композиция;
Этот небольшой набор слов вызывает в моей голове достаточно образов, чтобы соединить их в одну композицию. Обратите внимание, что я не только записала конкретные объекты, но и слова, описывающие настроение на картинке, а также цвета и особенности композиции.
[image:   Фотоманипуляция, коллажирование, фото-Арт – способы превращения фотографий во что-то новое и интересное.-3]
[image:   Фотоманипуляция, коллажирование, фото-Арт – способы превращения фотографий во что-то новое и интересное.-4]
Маленькие наброски
Переходим к следующему этапу – наброски. Да-да, именно наброски! Но для этого вам не нужно быть экспертом в рисовании. Набросок можно изобразить в виде нескольких линий и простых фигур, так что любой новичок с этим справится.
Фотоманипуляция, по сути, – это пазл. Поэтому главная цель наброска – визуализировать расположение композиционных элементов. Закончив с этим, вы можете начать подбирать подходящие для коллажа картинки.
[image:   Фотоманипуляция, коллажирование, фото-Арт – способы превращения фотографий во что-то новое и интересное.-5]
Изобразите расположение элементов на маленьких набросках.
Кроме того, наброски дадут вам возможность поэкспериментировать с разными идеями перед тем, как приступить непосредственно к их реализации.
У вас могут возникнуть вопросы: «Должен ли основной объект находиться в центре? Или лучше справа?» Попробуйте разные варианты и посмотрите, какой из них наиболее удачный. Так вы сохраните время и силы на основной этап работы.
Для одной из последних работ со светлячками я набросала простенький рисунок, который вы видите на картинке ниже.
[image:   Фотоманипуляция, коллажирование, фото-Арт – способы превращения фотографий во что-то новое и интересное.-6]
Я всего лишь нарисовала контуры банок, несколько букашек и траву в виде линий. Это дало мне достаточно визуальных образов для создания финального результата.
В самом начале работайте с простыми композициями, которые вы знаете и понимаете! Например, обычный портрет по центру. Не усложняйте работу перспективой и сложными ракурсами.
Такие сложные проекты, которые не соответствуют уровню ваших навыков, могут демотивировать и отбить желание учиться дальше. Так что старайтесь трезво оценивать свои возможности!
Как выбрать фото для фотоманипуляции
Определившись с идеей, пора переходить к подбору картинок!
Я могу уверенно сказать, что потратила тысячи часов на поиски стоковых фото. Понимаю, что это звучит грустно. Но есть множество причин, почему вам следует настолько тщательно подходить к подбору фото.
Далеко не все стоковые фото одинаковые. Качество, размер, тематика, композиция могут разительно отличаться.
Где найти стоковые фото
Чтобы избежать проблем с нарушением авторских прав, используйте фото с бесплатных стоков, по премиальной подписке или свои собственные снимки. Большое количество качественных исходников за ежемесячную оплату можно найти на Envato Elements и других премиум-стоках.
Как искать стоковые фото
В процессе работы с фотоманипуляцией может случиться множество непредсказуемых ситуаций. Например, автор может удалить фото со стока, а порой очень сложно найти что-то подходящее.
Поэтому я поделюсь с вами несколькими советами по эффективному поиску фото на стоках:
· Держите рядом список слов, описывающих идею.
· Сперва просто добавляйте в закладки те фото, которые по вашему мнению могут подойти.
· Попробуйте использовать одновременно несколько ключевых слов в поисковом запросе, чтобы максимально сузить тематику поиска. Например, по запросам «девушка», «женщина» и «ребенок» вам выдадут множество снимков в совершенно разных категориях.
· Обращайте внимание на название/метки/тэги под фото.
· Добавьте в закладки несколько запасных фото, чтобы при необходимости можно было быстро и легко что-то заменить.
· Сразу скачивайте те снимки, которые вам на 100% нравятся и подходят.
· И не загоняйте себя в рамки. Будьте гибкими!
Использование своих фото
Также вы можете воспользоваться своими собственными снимками. Я очень это рекомендую!
В прошлом году я запустила личный проект по созданию автопортретов, в котором использовала свои фото. Это позволило мне не только улучшить свои навыки, но и развить в себе уверенность. Медленно, но четко, мои знания увеличивались, потому что для каждого фото я придумывала что-то новое.
[image:   Фотоманипуляция, коллажирование, фото-Арт – способы превращения фотографий во что-то новое и интересное.-9]
Использование своих фото даст вам больший простор для творчества. А в наши дни хороший снимок можно сделать даже на обычном смартфоне, если немного повозиться с освещением.
Практическое занятие №2.  Компьютерная обработка растрового изображения: стилизация фотографии «под вектор». Обработка фотографий в программе растровой графики
Как быстро из фотографии сделать стилизированный под вектор рисунок? Просто и быстро 
1. Дублируем слой Ctrl+J. Фильтр[image: 👉🏻]Усиление резкости[image: 👉🏻]"Умная" резкость. Эффект (200-300 %), радиус (чем больше фотография по размеру, тем больше показатель ставим), уменьшить шум (50%), жмём "ОК". Повторяем ещё раз усиление резкости.
2. Фильтр[image: 👉🏻]Стилизация[image: 👉🏻]Диффузия. Режим "Анизотропный". Изображение [image: 👉🏻] Вращение изображения [image: 👉🏻]По часовой стрелке. После чего повторяем "Диффузию". Несколько раз повторяем данную операцию, пока изображение не вернём в исходное положение.
3. Докинем резкости. Фильтр[image: 👉🏻]Усиление резкости[image: 👉🏻]"Умная" резкость. Дублируем слой Ctrl+J. Правой кнопкой мыши выбираем "Преобразовать в смарт-объект". Дублируем последний слой ещё дважды, чтобы получилось три смарт-объекта.
4. Для первого смарт-объекта переходим во вкладку Фильтр[image: 👉🏻]Галерея фильтров[image: 👉🏻]Имитация[image: 👉🏻]Аппликация. Уровни на максимум, чёткость краёв на максимум, простота краёв 7. Открываем параметры наложения фильтра и понижаем непрозрачность до 30 %. Это тени. Переходим к следующему. Повторяем аналогичную операцию дважды, снижая на каждом последующем слое простоту краёв.
5. Ctrl + Alt + Shift + Е. Ctrl + Shift+ U обесцвечиваем. Открываем вкладку Изображение [image: 👉🏻] Коррекция [image: 👉🏻] Постеризация (уровни 11). Режим наложения "Мягкий свет" или "Перекрытие". Ctrl + Alt + Shift + Е. Фильтр[image: 👉🏻]Другое[image: 👉🏻]Краевой контраст. После чего можно немного подкорректировать кривые.
[image: ]
Практическое занятие №3. Создание рекламной листовки в программе Photoshop
Подготовка документа
Шаг 1
Создаем новый документ размером 216х154 миллиметров. Это размер формата А5 с отступами по краям в 3 мм. Так как данная работа предназначена для печати, устанавливаем цветовой режим на CMYK и разрешение на 300 пикселей/дюйм.
[image: https://i2.wp.com/photoshop-master.ru/lessons/les2579/02.jpg]
Шаг 2
Добавляем направляющие, чтобы отметить отступы по краям. Используем инструментMove Tool (V) (Перемещение) и клавишу Shift, чтобы откорректировать положение направляющих.
[image: https://i2.wp.com/photoshop-master.ru/lessons/les2579/03.jpg]
Шаг 3
Добавляем направляющие по всем сторонам документа.
[image: https://i0.wp.com/photoshop-master.ru/lessons/les2579/04.jpg]
Создаем фон
Шаг 1
Жмем Shift+Ctrl+N, чтобы создать новый слой. Заливаем его белым цветом (Alt+Backspace). Убедитесь, что на панелиColor (Цвет) установлены ползунки CMYK.
[image: https://i0.wp.com/photoshop-master.ru/lessons/les2579/05.jpg]
Шаг 2
Кликаем на кнопкуAdd a Layer Style (Добавить стиль слоя) внизу панели слоев и выбираемGradient Overlay (Перекрытие градиентом). Белый ползунок ставим на 30%. Цвет черного ползунка меняем на бледно-желтый (C=9 M=6 Y=14 K=0).
[image: https://i2.wp.com/photoshop-master.ru/lessons/les2579/06.jpg]
[image: https://i2.wp.com/photoshop-master.ru/lessons/les2579/07.jpg]
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Шаг 3
С помощьюRectangle Tool (U) (Прямоугольник) создаем прямоугольник. Размер вводим 216 х 56 мм.

[image: https://i0.wp.com/photoshop-master.ru/lessons/les2579/09.jpg]
Шаг 4
Привязываем прямоугольник к верхнему левому углу документа. Заливаем его темно-коричневым (C=49 M=74 Y=80 K=70).
[image: https://i1.wp.com/photoshop-master.ru/lessons/les2579/10.jpg]
Шаг 5
С помощьюPen Tool (P) (Перо) добавляем узелок на нижней части прямоугольника.
[image: https://i1.wp.com/photoshop-master.ru/lessons/les2579/11.jpg]
Шаг 6
С помощьюDirect Selection Tool (A) (Частичное выделение) начинаем редактировать направляющие узелка, чтобы создать кривую Безье.
[image: https://i0.wp.com/photoshop-master.ru/lessons/les2579/12.jpg]
Шаг 7
Продолжаем редактировать прямоугольник, как показано ниже.
[image: https://i2.wp.com/photoshop-master.ru/lessons/les2579/13.jpg]
Шаг 8
ПереходимFile - Place Embedded (Файл - Поместить встроенные), затем выбираем изображение people-1.jpg из набора, который вы должны были скачать в начале урока.
[image: https://i0.wp.com/photoshop-master.ru/lessons/les2579/14.jpg]
Шаг 9
ИспользуемMove Tool (V) (Перемещение), чтобы разместить фото в верхнем левом углу, как показано ниже.
[image: https://i1.wp.com/photoshop-master.ru/lessons/les2579/15.jpg]
Шаг 10
С помощьюRectangle Tool (U) (Прямоугольник) создаем прямоугольник в режимеPath (Контур). Размер вводим 216 х 100 мм.
[image: https://i0.wp.com/photoshop-master.ru/lessons/les2579/16.jpg]
Шаг 11
С помощьюDirect Selection Tool (A) (Частичное выделение) перемещаем прямоугольник прямо на фото в верхнем левом углу.
[image: https://i2.wp.com/photoshop-master.ru/lessons/les2579/17.jpg]
Шаг 12
АктивируемRectangle Tool (U) (Прямоугольник) и на верхней панели параметров инструмента кликаем по кнопкеMask (Маска). В результате на слое с фотографией появится векторная маска.
[image: https://i1.wp.com/photoshop-master.ru/lessons/les2579/18.jpg]
Шаг 13
С помощьюPen Tool (P) (Перо) добавляем новый узелок на маске. Затем, используяDirect Selection Tool (A)(Частичное выделение), создаем кривую Безье.
[image: https://i1.wp.com/photoshop-master.ru/lessons/les2579/19.jpg]


Шаг 14
Используя те же инструменты (Перо и Частичное выделение), редактируем маску, как показано ниже. Обратите внимание на положение узелков и на простоту формы. Чем меньше узелков, тем более гладким и аккуратным будет результат.
[image: https://i2.wp.com/photoshop-master.ru/lessons/les2579/20.jpg]
Шаг 15
ПереходимFilter - Blur - Gaussian Blur (Фильтр - Размытие - Размытие по Гауссу). Устанавливаем Radius (Радиус) на 6.
[image: https://i0.wp.com/photoshop-master.ru/lessons/les2579/21.jpg]
Шаг 16
Кликаем по маске смарт-фильтра и заливаем ее черно-белым градиентом от левого края к правому.
[image: https://i2.wp.com/photoshop-master.ru/lessons/les2579/22.jpg]
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Шаг 17
Добавляем к фото новую слой-маску. Мягкойкисточкой (В) аккуратно стираем правый край.
[image: https://i2.wp.com/photoshop-master.ru/lessons/les2579/24.jpg]
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Шаг 18
Создаемкорректирующий слой Brightness/Contrast (Яркость/Контрастность). Для этого кликаем на иконку(Создать новую заливку или корректирующий слой). Устанавливаем Brightness (Яркость) на 40 и Contrast (Контрастность) на 10.
[image: https://i0.wp.com/photoshop-master.ru/lessons/les2579/26.jpg]
Шаг 19
Кликаем правой кнопкой по корректирующему слою и выбираемCreate Clipping Mask (Создать обтравочную маску). Благодаря этому, коррекция будет действовать только на фото ниже.
[image: https://i1.wp.com/photoshop-master.ru/lessons/les2579/27.jpg]
Шаг 20
Кликаем на кнопкуCreate new fill or adjustment layer (Создать новую заливку или корректирующий слой) внизу панели слоев и выбираемSolid Color (Цвет). Цвет заливки устанавливаем на коричневый (C=30 M=80 Y=100 K=30).
[image: https://i0.wp.com/photoshop-master.ru/lessons/les2579/28.jpg]
Шаг 21
Жмем по векторной маске фотографии. Зажимаем клавишу Alt и перетаскиваем маску на слой с цветовой заливкой. В результате маска скопируется.
[image: https://i1.wp.com/photoshop-master.ru/lessons/les2579/29.jpg]
Шаг 22
С помощьюDirect Selection Tool (A) (Частичное выделение) перетаскиваем правый верхний узелок в угол.
[image: https://i1.wp.com/photoshop-master.ru/lessons/les2579/30.jpg]
Шаг 23
Беремкисть (В) и редактируем маску, чтобы убрать часть заливки. Непрозрачность коричневого слоя установите на 75%.
[image: https://i1.wp.com/photoshop-master.ru/lessons/les2579/31.jpg]
Шаг 24
БеремRectangle Tool (U) (Прямоугольник) и рисуем новый прямоугольник.
[image: https://i1.wp.com/photoshop-master.ru/lessons/les2579/32.jpg]
Шаг 25
Заливаем прямоугольник светло-коричневым цветом (C=10 M=65 Y=100 K=0).
[image: https://i0.wp.com/photoshop-master.ru/lessons/les2579/33.jpg]
Шаг 26
Размещаем слой со светлым прямоугольником под темным.
[image: https://i1.wp.com/photoshop-master.ru/lessons/les2579/34.jpg]
Шаг 27
С помощьюPen Tool (P) (Пера) иDirect Selection Tool (A) (Частичное выделение) редактируем прямоугольник, как показано ниже.
[image: https://i1.wp.com/photoshop-master.ru/lessons/les2579/35.jpg]
Добавляем текст и логотип
Шаг 1
Создаем окружность с помощьюEllipse Tool (U) (Эллипс). Размер фигуры - 248 х 248 px. Заливаем ее коричневым цветом (C=30 M=80 Y=100 K=30).
[image: https://i1.wp.com/photoshop-master.ru/lessons/les2579/36.jpg]
Шаг 2
Добавляем стиль слояDrop Shadow (Тень). УстанавливаемOpacity (Непрозрачность) на 14%,Distance (Расстояние) на 5 px и Size (Размер) на 15 px.
[image: https://i1.wp.com/photoshop-master.ru/lessons/les2579/37.jpg]
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Шаг 3
Создаем еще одну окружность размером 400 х 400 px. Заливаем ее темно-синим цветом (C=100 M=80 Y=45 K=50).
[image: https://i0.wp.com/photoshop-master.ru/lessons/les2579/39.jpg]
Шаг 4
Ко второй окружности также применяем стиль слояDrop Shadow (Тень). Для этого кликаем правой кнопкой по слою с первой окружностью и выбираемCopy Layer Style (Копировать стиль слоя), затем правой кнопкой по второй и выбираемPaste Layer Style (Вставить стиль слоя). Синюю окружность размещаем под коричневой.
[image: https://i1.wp.com/photoshop-master.ru/lessons/les2579/40.jpg]
Шаг 5
С помощьюType Tool (T) (Текст) пишем текст. В этом уроке использован шрифтProxima Nova . Размер текста с ценой 17 pt. Все строки создаем как отдельные слои. С помощьюMove Tool (V) (Перемещение) размещаем текст в окружности, как показано ниже.
[image: https://i1.wp.com/photoshop-master.ru/lessons/les2579/41.jpg]
Шаг 6
Добавляем текст на синей окружности. Размер самого крупного текста 31 pt.
[image: https://i2.wp.com/photoshop-master.ru/lessons/les2579/42.jpg]
Шаг 7
Продолжаем добавлять текст. Шрифт - Proxima Nova Light, размер - 18 pt.
[image: https://i1.wp.com/photoshop-master.ru/lessons/les2579/43.jpg]
Шаг 8
Пишем еще текст. Размер - 36 pt. Устанавливаем Tracking (Трэкинг) на -10.
[image: https://i1.wp.com/photoshop-master.ru/lessons/les2579/44.jpg]
Шаг 9
Выделяем оба текстовых слоя. Зажимаем клавишу Alt и тянем их ниже, чтобы дублировать.
[image: https://i2.wp.com/photoshop-master.ru/lessons/les2579/45.jpg]
Шаг 10
С помощьюType Tool (T) (Текст) редактируем дубликаты текста, как показано ниже.
[image: https://i2.wp.com/photoshop-master.ru/lessons/les2579/46.jpg]
Шаг 11
ПереходимFile - Place Embedded (Файл - Поместить встроенные) и в открывшемся окне выбираем файл acme-travel-logo.ai.
[image: https://i1.wp.com/photoshop-master.ru/lessons/les2579/47.jpg]
Шаг 12
Уменьшаем размер логотипа и размещаем его в верхнем правом углу.
[image: https://i1.wp.com/photoshop-master.ru/lessons/les2579/48.jpg]
Шаг 13
Добавляем стиль слояDrop Shadow (Тень). УстанавливаемOpacity (Непрозрачность) на 11%,Distance (Расстояние) на 3 px и Size (Размер) на 16 px.
[image: https://i1.wp.com/photoshop-master.ru/lessons/les2579/49.jpg]

Раздел 2. Выбор основных изобразительных средств рекламной фотографии
Тема 2.1. Использование студийного оборудования, технология фотогравирования
Практическое занятие №1. Схемы установки студийного освещения для решения основных задач рекламной фотосессии.
Существует стереотип, что искусственный свет – это очень сложно, а студийные съемки – прерогатива фотографов с особыми умениями. Неудивительно, что первые съемки в студии обычно очень волнительны. Но все не так страшно, если подготовиться к фотосессии заранее.
 Для повторения нижеприведенных схем понадобится следующее оборудование:
· насадки: рефлектор, портретная тарелка, софтбокс, октобокс, серебряный зонт, стрипбокс – лучше длинный для удобства съемки в полный рост;
· 3 моноблока;
· белые и черные флаги – предпочтительно человеческого роста или чуть выше.
Схемы света для студийной фотосъемки
В первую очередь напомним, что свет в студии – не таблица умножения, его не нужно зубрить. Используйте схемы съемки в студии, чтобы понять свет и научиться им управлять. 
В этой статье подробно разберем 10 базовых световых схем. Освоив их, вы сможете экспериментировать с освещением в студии, модифицировать готовые схемы и создавать новые, наиболее подходящие под конкретную съемку.
Схема 1. Осветительный прибор с серебряным зонтом + два осветителя со стрипбоксами позади модели + белые панели
Рисующий свет устанавливается левее камеры. 2 осветителя устанавливаются по бокам и чуть сзади модели. Между фоном и светильниками устанавливаются 2 белые панели, чтобы контровики не повлияли на фон. 
Эта схема дает мягкий свет спереди и контровый с двух сторон, что отлично подходит для красивой обрисовки контуров тела или скул. 
Все источники схемы можно передвигать в стороны, наклонять для достижения оптимального светового эффекта или менять соотношение мощностей источников. Например, ярким рисующим источником (зонт спереди) можно хорошо выделить лицо, более приглушенным – поместить его почти в тень, а основной рисунок получить от контрового света стрипбоксов.
[image: Осветительный прибор с серебряным зонтом + два осветителя со стрипбоксами позади модели + белые панели]
Схема 1. Осветительный прибор с серебряным зонтом + два осветителя со стрипбоксами позади модели + белые панели
 Схема 2. Стандартные рефлекторы + белые панели
Модель не должна стоять вплотную к фону, попросите ее отодвинуться ближе к середине площадки. 2 рефлектора с белыми панелями устанавливаются позади модели под углом 45 и 135 градусов соответственно, как указано на рисунке.
Белые панели выполняют функцию контрового света, отражая падающий от рисующего свет. Фон получается абсолютно белым, без тени от модели.
Белый фон часто используют на коммерческих съемках. Большинство интернет-магазинов выбирают его для демонстрации продукции, потому что нейтральный тон не отвлекает внимание покупателя от товара.
[image: Стандартные рефлекторы + белые панели]
Схема 2. Стандартные рефлекторы + белые панели
Схема 3. Светильник с октобоксом + ростовой стрипбокс (съемка в полный рост)
Стрипбокс устанавливается слева от модели. В качестве рисующего света выступает светильник с октобоксом, выставленный перед моделью, как показано на рисунке. При таком расположении источников мы получаем хорошо освещенную модель, выделяющуюся на сером фоне.
[image: Схема 3]
Схема 3. Светильник с октобоксом + ростовой стрипбокс
Схема 4. Моноблок с октобоксом + две широкие отражающие панели
Рисующий свет дает моноблок с октобоксом – это единственный источник света в этой схеме. По бокам модели устанавливаем две широкие отражающие панели – они будут заполняться светом. 
При такой постановке источников фон освещается равномерно, а рисующий свет получается мягким. Дополнительный плюс октобокса – это отсутствие квадратных бликов в глазах модели.
[image: Моноблок с октобоксом + две широкие отражающие панели]
Схема 4. Моноблок с октобоксом + две широкие отражающие панели
Схема 5. Октобокс + контровой стрипбокс, отделенный от фона отражателем
Рисующим светом здесь выступает октобокс, контровым – стрипбокс. Между фоном и стрипбокосм поместим отражатель, чтобы уменьшить его влияние на фон.
Моноблок с рефлектором и сотами устанавливается за спиной модели и направляется на фон. Это сделает фон градиентным.
[image: Октобокс + контровой стрипбокс, отделенный от фона отражателем]
Схема 5. Октобокс + контровой стрипбокс, отделенный от фона отражателем
Схема 6. Моноблок с октобоксом + две широкие отражающие панели + фоновый светильник со стандартным рефлектором и сотами
Преобразуем схему 4, добавив фоновый источник.
Осветим фон источником со стандартным рефлектором и сотами, чтобы создать уже знакомый градиент и изменить настроение кадра.
[image: Моноблок с октобоксом + две широкие отражающие панели + фоновый светильник со стандартным рефлектором и сотами]
Схема 6. Моноблок с октобоксом + две широкие отражающие панели + фоновый светильник со стандартным рефлектором и сотами
Схема 7. Осветитель с длинным стрипбоксом + черные светопоглощающие панели
Оптимальный вариант освещения при съемке высокой модели. Осветители с длинными стрипбоксами выставляются по диагонали перед моделью (это рисующий свет) и позади (контровый). По бокам модели устанавливаются черные светопоглощающие панели.
Длинный стрипбокс позволяет равномерно осветить модель в полный рост, а черные флаги по бокам отсекают лишние переотражения, делая тени более глубокими и объемными.
[image: Осветитель с длинным стрипбоксом + черные светопоглощающие панели]
Схема 7. Осветитель с длинным стрипбоксом + черные светопоглощающие панели
Схема 8. Светильник с октобоксом + источник со стрипбоксом + отражатели
Схема для создания приглушенного освещения фона и обрисовки модели контурным светом. Октобокс и источник со стрипбоксом устанавливаются по диагонали перед и за моделью, как показано на изображении. Для заполнения кадра справа от модели устанавливается отражатель.
[image: Светильник с октобоксом + источник со стрипбоксом + отражатели]
Схема 8. Светильник с октобоксом + источник со стрипбоксом + отражатели
Схема 9. Источник с серебряным зонтом (направленный круто вниз)
Простая схема с одним источником, позволяющая добиться драматического настроения фото. Источник рисующего света устанавливается с правой стороны камеры чуть выше человеческого роста и направляется на модель. Свет как бы смотрит на модель сверху вниз.
В этой схеме можно менять наклон зонта и расстояние до модели. Если поставить ближе, то наклоненный сильно вниз зонт даст очень драматичный свет. Если дальше, то свет будет менее резким.
[image: Источник с серебряным зонтом]
Схема 9. Источник с серебряным зонтом
Схема 10. Портретная тарелка (с сотовой решеткой) + светопоглощающие панели + стандартный рефлектор
Эта схема позволяет выделить черную вещь на темном фоне. Чаще всего применяется для крупных портретов, но иногда подходит и для ростовых кадров.
По бокам модели выставляются черные флаги (их еще называют французскими флагами). Они помогают избежать переотражения от светлых, цветных поверхностей или от модели и добавляют контрастности теням, делая их темнее и объемнее. Фон подсвечивается рефлектором.
Портретная тарелка дает объемный свет средней мягкости, но нюансы мягкости и жесткости зависят от размера и цвета тарелки. Большая тарелка будет немного мягче, чем тарелка меньшего размера, а белая тарелка – мягче, чем серебряная.
Соты придают направленность свету, как бы собирают его, делая световое пятно более узким.
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Схема 10. Портретная тарелка (с сотовой решеткой) + светопоглощающие панели + стандартный рефлектор

Практическое занятие №2. Использование насадок и фильтров на приборы студийного освещения, для создания специфического светового рисунка на рекламируемом объекте.
Для чего нужны студийные насадки
В настоящее время для фотосъемок в студиях и интерьерах наиболее часто используются студийные импульсные осветители. Ввиду малой поверхности излучения импульсных ламп эти приборы в «чистом виде» можно считать точечными источниками света, поэтому для получения хорошо сбалансированного освещения и создания специальных световых эффектов их явно недостаточно. Кроме точечных источников «жесткого» света, в состав студийного комплекта должны входить также источники рассеянного света с различной формой и величиной площади излучаемой поверхности. Для того чтобы можно было имитировать естественное освещение и создавать всевозможные световые эффекты, фотограф должен иметь приборы, различающиеся такими характеристиками света как сила светового потока, угол распространения, цвет.
Зонты
Складные зонты являются самыми доступными и удобными, особенно, при съемке на выезде, насадками на осветительные приборы. Наиболее удобны для работы и транспортировки зонты, имеющие диаметр от 80 до 120 см. Но выпускаются и модели диаметром до двух метров. Зонты используют не только в фотографии, но и при видеосъемке с галогенными осветителями. Они позволяют получить «полумягкий» и рассеянный свет. Зонты бывают просветными, то есть, рассеивающими свет, проходящий через белую ткань, из которой они сшиты, а также отражающими. У отражающих зонтов, нерабочая, внешняя поверхность выполняется из черной ткани, а рабочая может быть либо белой с высоким коэффициентом диффузного отражения, либо металлизированной. Металлизированная ткань бывает серебристой или золотистой.
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Просветные зонты
Просветные зонты заметно рассеивают световой поток, создаваемый импульсной лампой, и ослабляют его минимум в два раза. Прошедший через зонт свет может, в зависимости от поставленных задач, служить как рисующим, так и заполняющим. Хороший пример просветного зонта – модель диаметром 108 см производства Rekam.
Отражательные зонты
Отражательные зонты ( Rekam зонт 100см , Falcon Зонт-отражатель UR-32g ) также дают мягкий свет. Зонт с матово-белой отражающей поверхностью позволяет получить самый мягкий свет, однако его КПД, ввиду больших потерь света из-за диффузного отражения и нагрева, минимален. Серебристые зонты немного увеличивают цветовую температуру импульсных ламп, что нужно помнить, особенно при съемке на слайдовую пленку. Золотистые зонты, напротив, заметно уменьшают цветовую температуру источника света, что позволяет их использовать для получения «теплых» теней при портретной и предметной съемке. Меняя расстояние от центра отражательного зонта до источника света, можно получать более либо сходящийся, либо состоящий из почти параллельных лучей пучок света. Параболические зонты, которые позволяют управлять световым потоком с большей эффективностью, чем сферические, к сожалению, не получили широкого распространения по причине своей высокой цены.
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Стандартные рефлекторы
Стандартные рефлекторы могут работать самостоятельно, давая жесткий направленный свет и резкие тени, а также в сочетании с фильтродержателями для фолиевых или сотовых фильтров. На стандартные рефлекторы нередко устанавливаются шторки.
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Фоновые рефлекторы
Для освещения студийных фонов или другого заднего плана существуют специальные фоновые рефлекторы, задача которых – не только обеспечить равномерное распределение освещения, но и исключить попадание света в объектив камеры. ( Hensel 156 backlight рефлектор, Rekam универсальный рефлектор для evolution и promo ). Приборы с такими насадками чаще устанавливаются на полу или на подвесных системах, но могут работать и со штативов или штанг.
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Другие типы рефлекторов
Для ограничения светового потока определенным углом существуют различные параболические рефлекторы. В их маркировке или технических характеристиках обычно указывается длина рабочей части и максимальный угол, распространения света (например, Рефлектор Elinchrom 16 см, 90 градусов).
 Рассеивающие рефлекторы обычно по форм и размерам напоминают спутниковые «тарелки». Их рабочая поверхность выполняется с матовым белым или металлическим покрытием. Софт-рефлекторы снабжаются одним или несколькими дефлекторами – небольшими отражателями, которые устанавливаются напротив источника света (импульсной и пилотной ламп). Дефлекторы с одной стороны препятствуют прямому попаданию света на объект, с другой – усиливают световой поток от основного рефлектора в сторону объекта.
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Есть также софт-рефлекторы, имитирующие солнечное освещение. У подобных устройств вместо дефлектора напротив лампы устанавливается сотовый фильтр. Световой поток от такого рефлектора состоит из пучка практически параллельных лучей, прошедших через соты, и мягкой рассеянной подсветки от остальной поверхности рефлектора.
[bookmark: _Toc229300858][bookmark: soft]Софт-боксы
В буквальном переводе с английского soft-box означает «мягкий ящик» или «мягкая коробка». Это название можно толковать двояко. С одной стороны, любой софт-бокс представляют собой не жесткую, а легкую сборную конструкцию из тонкого, складывающегося наподобие зонта, стального каркаса, обтягивающегося плотной тканью. С другой стороны, все софт-боксы являются средствами для получения мягкого света (soft light), что также могло сыграть свою роль в возникновении их названия.
Каркас софт-бокса состоит из основы, металлического кольца, к которому с одной стороны крепятся стальные спицы, а с другой — адаптер для установки на осветительном приборе. Каркас обтягивается чехлом, состоящим из двух слоев ткани. Внешний черный слой является защитным, а внутренний представляет собой металлизированную ткань, которая, принимая форму, заданную ей каркасом, становится рефлектором, отражающим весь падающий свет на экран-диффузор. Экраном софт-бокса обычно является кусок специальной ткани, хорошо рассеивающей проходящий через нее свет, и почти не влияющей на его спектральный состав.
Основные типы софт-боксов
Наибольшее распространение получили четырехугольные софт-боксы: квадратные, прямоугольные, «стрипы». «Стрипами» или стрип-боксами называются узкие прямоугольные боксы, длина которых в несколько раз превышает ширину и составляет 1-2 метра. Такие софт-боксы используются для равномерного мягкого освещения относительно крупных объектов (людей во весь рост, элементов интерьера, автомобилей и т. п.) с близкого расстояния.
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В особый вид софт-боксов выделяются окто-боксы («окто» — «восемь» по-латыни). Эти восьмиугольные боксы диаметром до двух метров могут, к примеру, использоваться в качестве рисующего света при съемке групповых портретов. Более «мелкие» октобоксы часто применяются в портретной или предметной съемке, когда фотографу хочется получить почти круглую форму бликов в глазах модели или на глянцевых поверхностях предметов.
Шторки
Falcon eyes шторки ssa-bd, Rekam шторки rb-4001 – насадки с двумя парами подвижных кулис, с помощью которых можно оперативно ограничивать угол распространения света от рефлектора. Шторки устанавливаются на универсальный держатель, куда вместе с ними могут также устанавливаться фильтры и соты. Чаще всего шторки требуются при освещении фона и для управления контровым светом.
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Держатель фолиевых фильтров служит для фиксации цветных, диффузионных или нейтральных фильтров в рамке универсального держателя на рефлекторе. Держатель представляет собой две тонкие металлические пластины с отверстиями большого диаметра. Фолиевый фильтр зажимается между пластинами и вставляется в универсальный держатель.
Соты
Соты — Rekam Ef-508, Rekam Сотовая решетка для alr114 ah-6020 — насадка, имеющая, как видно из ее названия, мелкоячеистую структуру, и служащая для получения пучка параллельных (или очень близких к параллельным) лучей.
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Чем меньше диаметр каждой ячейки, «соты», и больше ее глубина (толщина насадки), тем меньше будет угол расхождения светового пучка на выходе. Мелкие соты, имеющие достаточную толщину, позволяют получать световые пятна практически того же размера, который имеет источник (в данном случае – сотовая насадка).
Соты применяются для контрового света (они не дают отражения в сторону объектива и позволяют обходиться без шторок и затенителей) и для имитации солнечного света, поскольку, как и солнце, дают пучок параллельных лучей.
Кроме небольших сотовых насадок, устанавливающихся на универсальном держателе стандартного рефлектора, существуют соты большой площади, предназначенные для софт-боксов. Они могут быть жесткими алюминиевыми или эластичными, сделанными из ткани, натянутой на упругое кольцо из стальной ленты (типа гибких складных отражателей).
Цветные фильтры
Цветные фильтры используются для изменения спектрального состава света.
 В отличие от светофильтров, которые надеваются на объективы камер и оказывают действие на все изображение или большую его часть (зональные Ф.), фильтры, устанавливающиеся на отдельные осветительные приборы, позволяют получать множество вариантов цветовой партитуры и в умелых руках являются важным средством художественной выразительности.
 Со студийными вспышками в настоящее время применяются цветные фильтры нескольких типов. Фолиевые (пленочные) фильтры представляют собой окрашенную полимерную пленку, которая продается в рулонах или уже в нарезанном под размер фильтродержателя виде. При наиболее распространенном способе установки, квадратный фильтродержатель с фильтром вставляется в специальный паз универсального держателя на стандартном рефлекторе. Но могут быть и другие варианты. ( Falcon eyesфильтр для ведомой вспышки ssa-hc ) В частности, фолиевый фильтр может быть закреплен в круглой металлической оправе, которая затем вставляется в держатель для сот или в тубус. При работе с фолиевыми фильтрами следует помнить, что они очень чувствительны к высоким температурам, поэтому пользоваться пилотным светом нужно очень осторожно, включая его только на время установки света.
 Цветные фильтры для студийных вспышек могут также выполняться в виде колпачков из твердого прозрачного полимера и надеваться непосредственно на рефлекторы. ( Falcon eyesфильтр для ведомой вспышки ssa-cf )
 Для популярных среди любителей вспышек REKAM Minilight 60 Дж выпускается недорогой набор полусферических цветных фильтров пяти цветов, которые накручиваются на вспышку как колпачки.
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[bookmark: _Toc229300860][bookmark: comp]Совместимость осветительных приборов и насадок
Поскольку разработкой и производством студийных импульсных приборов занимаются многие компании, вполне естественно, что все подобные приборы имеют свои оригинальные байонеты – штыковые крепления насадок к корпусу моноблока. Крепления разных фирм отличаются диаметром и конструкцией.
К самым распространенным в России относятся байонеты:
1. Broncolor
2. Bowens
3. Elinchrom
4. Falcon серия DE/FE
5. Hensel
6. Multiblitz
7. Rekam-Classic

Тема 2.2. Работа над имиджевой фотографией, фотосессия предметов потребления.
Практическое занятие №1. Компоновка и финишное решение для рекламной композиции натюрморта предметов потребления. 
1. Принципы дизайна
Первое правило композиции относится к знанию элементов и принципов дизайна. Есть некоторые базовые элементы, которые мы используем для создания любой работы. Они составляют структуру дизайна. Это такие элементы как:
· цвет — обладает оттенком, насыщенностью и т.д.,
· яркость — светлый/темный элемент, что особенно важно для монохромных изображений,
· линия — может быть прямой, изогнутой, толстой, тонкой, жирной,
· форма — обычно двухмерные (например, квадрат),
· фигуры — трехмерные (например, куб),
· текстура — зависит от таких качеств поверхности как блеск, глянец, "мокрая", "песочная" структура,
· пространство — расстояние между объектами.
Что касается принципов дизайна, то они помогают дизайнеру создать эффективную для восприятия рекламную композицию. Основные принципы дизайна:
· баланс — это то, как элементы сорганизуются друг с другом, образуя устойчивость (симметрия, асссиметрия),
· акцент — когда один элемент композиции доминирует над остальными,
· гармония — подходящее сочетание компонентов,
· динамика — расположение элементов таким образом, чтобы создавалось ощущение движения, а также создания траектории для взгляда,
· ритм — повтор элементов для создания эффекта движения,
· пропорция — то, как разные части соотносятся с остальными,
· целостность — объединение элементов в одно целое,
· разнообразие — благодаря ему композиция получается интересной и не монотонной.
2. Правило трех
"Правило трех" иногда связывают с "золотым сечением", что не совсем верно. "Золотое сечение" — это математическая функция, используемая в искусстве и архитектуре, рассказывающая об идеальном расстоянии между объектами для их лучшего восприятия. "Правило трех" больше относится к дизайну и является законом композиции.
"Правило трех" говорит о том, что путем равномерного деления дизайнерской картинки с помощью горизонтальных и вертикальных линий — каждые четыре из них будут создавать 9 частей. Пересечения этих линий — это фокусные точки изображения или фотографии. И в этих точках объект воспринимается лучше всего. Вот фотография ребенка на пляже — такая, какой мы ее видим изначально.
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Теперь проведем интересный эксперимент, нарисовав две горизонтальные и две вертикальные линии, разделив фото на девять равных частей.
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Теперь давайте немного поиграем с фокусными точками. Какова фокусная точка фотографии? На что мы хотим обратить внимание глаза? Скорее всего, это голова мальчика. Теперь мы регулируем сетку так, чтобы переместить одно из четырех пересечений на нашу фокусную точку.
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Теперь мы просто обрезаем изображение согласно новым границам. Вот как фото выглядит теперь.
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Видите разницу? "Правило трех" работает во многих видах рекламы. Вот пример — реклама Ассоциации Американских газет.
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Как видно на картинке, фокусная точка изображения не находится непосредственно на пересечении двух линий. Однако она все равно работает, так как находится рядом. Как в этой рекламе дезодоранта Axe.
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3. Правило нечетного числа и "воздуха"
Правило говорит о том, что любая работа будет более привлекательной, если:
a) она изображает нечетное количество объектов,
b) на картинке есть свободное пространство — так называемый "воздух", который позволяет глазам "дышать".
Возможно, успех этого правила связан с тем, что при изображении нечетного количества объектов один из них будет находиться в центре внимания, что делает восприятие работы более комфортной. Вот как это функционирует в рекламе Harvey Nichols.
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Вторая составляющая этого правила — "воздух" говорит о том, что, когда вы, к примеру, изображаете человека, который смотрит в правый верхний угол, вы должны поместить самого человека в нижнем левом (фокусная точка) и оставить пространство. Это заставляет воображение зрителя работать. Вот как используется пространство в рекламе Eurostar.
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4. Правило траектории взгляда
Никогда не оставляйте зрителя в одиночестве. Дизайнер должен контролировать взгляд смотрящего. Фокусную точку и окружающие объекты нужно разместить так, чтобы задать траекторию взгляда. Если все сделать правильно, то глаза зрителя последуют по проложенному вами пути, а, значит, реклама будет воспринята правильно.
Это особенно важно в рекламе, где потребитель должен получить определенное послание. Например, при создании визуальной рекламы вы хотите, чтобы зритель сначала посмотрел на картинку и только потом прочитал текст. Таким образом, изображение становится как бы ключом ко всей рекламе — благодаря эмоциональности "крючка" человек сначала воспринимает картинку, и затем обращает внимание на текст, который выступает своего рода рациональной частью рекламы. Так как потребитель видит текст последним, то он лучше его запоминает.
Чтобы "проложить путь" для глаз, мы используем следующие элементы:
· зоны наилучшего восприятия информации,
· указатели, лиды,
· подсказки, намеки, стрелки,
· блоки,
· выходы.
Вот как это работает в рекламе Axe.
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5. Не делай два интервала одинаковыми
Это правило художника Грега Альберта. Фактически он сводит все перечисленные правила к одному: никогда не делать два интервала, две длины, два пространства, два размера одинаковыми. Если в картинке слишком много повторений (например, повторений интервалов), это повергает в скуку и лишает изображения привлекательности.
Заказывая дизайн рекламы в нашей студии, вы можете быть уверены, что реклама будет эффективна не только с точки зрения композиции, но и с учетом психологических законов восприятия информации потребителем. Лотерейные билеты, флажки, годовые отчеты, календари, брошюры, каталоги, газеты, воздушные шары, запись CD — эта и другая продукция изготавливается специалистами высокого класса, знающими законы успешной рекламы.

Практическое занятие №2. Фотографирование визуального проекта имиджевой фотосессии.
Предметная имиджевая съемка — это создание рекламных фотографий товаров для размещения их на различных ресурсах:
- на маркетплейсах, Wildberries фото, Ozon фото, Lamoda и другие.
- баннерах
- предметная фотосъемка для интернет магазина в Москве
- съемка товаров для сайта
- предметное фото для инстаграм
- фотографии для магазинов
Фотографии для магазинов должны усиливать лучшие качества товара, привлекать внимание покупателей и главное продавать.
А теперь давайте разберемся какие виды предметной съемки бывают.
1. Предметная съемка на белом или сером фоне – это предметная съемка для магазина -интернет, буклетов, каталогов, съемка товаров для сайта, wildberries фото.
В большинстве случаев требуется три-пять ракурсов на артикул.
Как правило получается предметная съемка не дорого за одну фотографию.
Тем не менее и здесь есть некоторые нюансы, влияющие на ценообразование: размер, поверхность продукта (матовый или глянцевый), количество товаров. Чем больше количество, тем ниже цена за единицу.
2. Предметная Имиджевая съемка – имиджевая съемка отличается от съемки на белом фоне тем, что собирается с реквизитом для фотосессии.
К рекламной фотосессии требуется подготовка, это:
- создание концепции
- подбор референсов
- реквизит для фотосессии
- согласование материала с заказчиком перед самой съемкой.
Имиджевую съемку используют для наружной рекламы, для фото на Вайлдберис, фото для Озон, предметное фото для инстаграм.
Имиджевая предметная съемка на заказ требует больше времени, больше расходов на реквизит для фотосессии, особых навыков у предметного фотографа, вкуса, насмотренности.
3. Предметная съемка 360 – это фото или видео съемка товара, который вращается вокруг своей оси. Для такого вида съемки нужна специальная платформа.
Каталожная съемка
Это съемка, где основная задача фотографа — сделать качественные кадры на простом фоне, которые продемонстрируют покупателю продукт. Как правило, такие снимки создаются для интернет-магазинов и маркетплейсов.
Виды каталожной съемки
Раскладка – применяется для товаров, которые могут демонстрировать свои свойства без вспомогательных элементов. Например, для парфюмерии или аксессуаров. В отличие от одежды, которую нужно показывать на модели, они будут смотреться удачно самостоятельно.
Съемка с манекенами или моделями – проводится, когда для продажи товара нужно дать клиенту представление о фасоне, посадке, текстуре изделия.
Концептуальная съемка
Она отражает ценности не только товара, но и самой компании. Фотограф, который работает в этом направлении, как правило, активно использует реквизит и декорации, чтобы на уровне эмоций передать философию и концепцию бренда.
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[image: Рассказываю на своем опыте!-3-2]


[image: Рассказываю на своем опыте!-4-2]
Имиджевая съемка
Работает на восприятие покупателей. Имиджевые фотографии показывают, кто и в каких условиях использует продукцию бренда: что это за человек, чем он живет, какие у него вкусы и предпочтения. Если зритель считывает все эти образы и идентифицирует себя с ними, то он становится потенциальным покупателем бренда.
[image: Работа Дарьи Долгих — автора курса “Контент-фотограф”]    [image: Рассказываю на своем опыте!-5-2]
Задание для вас!
Представьте, что к вам в качестве клиента пришел бренд-бунтарь, который продает дерзкую молодежную одежду. Его основные ценности — свобода, самовыражение, выход за рамки. Какую имиджевую и концептуальную съемку контента вы бы ему предложили?
Перечень рекомендуемых учебных изданий и дополнительной литературы
по дисциплине «Разработка и размещение рекламного контента для продвижения торговой марки»

 
Основная литература:
1. Графический дизайн: стилевая эволюция:  И.Г. Пендикова, Л.М. Дмитриева - М.: Магистр, НИЦ ИНФРА-М, 2018. - 160 с
2. Основы художественного конструирования: Учебник / Коротеева Л.И., Яскин А.П. - М.:НИЦ ИНФРА-М, 2016. - 304 с.: 60x88 1/16. -  (Обложка) ISBN 978-5-16-009881-4
3. Фотомонтаж. Пособие для фотохудожников: Учебное пособие / Крылов А.П. - М.:КУРС, НИЦ ИНФРА-М, 2016. - 80 с.: 70x100 1/16 (Обложка. КБС) ISBN 978-5-905554-05-6Щербакова, К В. Компьютерная графика учебное пособие/К.В. Щербакова, Москва МГОУ 2010, 77 с. ил. 20 см, ISBN	978-5-7045-0976-9. http://znanium.com/catalog.php?bookinfo=458966

Дополнительная литература:
      1. Архитектурно-ландшафтный дизайн: теория и практика : учеб. пособие / Г.А. Потаев, А.В. Мазаник, Е.Е. Нитиевская [и др.] ; под общ. ред. Г.А. Потаева. — 2-е изд. — М. : ФОРУМ : ИНФРА-М, 2018. — 319 с., [32] с. цв. ил.

Интернет-ресурсы:
1. СПС http://www.consultant.ru
2. ЭБС https://znanium.com
3. ЭБС https://book.ru

image5.png




image84.jpeg




image85.png




image86.png
v eEEEE R JENAT BEKTOPHAIFEL X + = X
c rustube.cc/video/mf85MbJVyvI9RBNEsSiqug/ ¥ in} (s I ]
Movck suaeo, QHaiim

@ lnaewan
© Ton euaeo
Hosoctu
@ Cnopr

£ Myzbika
6 Vrpur

® tOmop

W KneotHele

A Asto

©0 Ceiiuac cmoTpaT
[ Vizbpattoe

D Uctopusa

P Mok

LYXV & Buae TUTEK
BuM AN Kak He...

Dari

h

8 uacos Hazan

B uew cexper ycnexa
BoasHOBO/ Montoe...

Crenaro

8 uacos

Jlwnur 3acTana Bpacnox
Guspyka Bacnns ...

KOT/JA MAMA YLINIA HA
POAMTENBCKOE,

BATI L

Koraa xusews 8
MHOTOAETHON CeMbe...

Katya Klon

asan

Comedy Club ¥1po nocre
KOprOpaTVEa XapAamos...

edy Club

KAK CAENATb BEKTOPHbI/ PUUCYHOK 113 $OTO B PHOTOSHOP (6e3 MHcTpyMmeHTa
«ﬂepo»)

9 uacoe

A

HOBARA PO/ UNYHLK B

(2 Buranuii Menuykosckwit 58,683 MpocmoTpos n
———— AMONG US MAIHKPA®T

O 4 ropa Hazan

& Hpaswrca
e .
Q@ " 2000 ¢eM0

EdisonPts

g = 20:05
3 TR R}





image87.jpeg
New
Name: |Travel Flyer AS —ox——)
Preset: | Custom K Cancel
Save Preset...
Width: 216 Millimeters - set.
Height: | 154 | Millimeters v
Resolution: 300 Pixels/Inch B

Color Mode: [ CMYK Color #| [ 8 bit

Background Contents: [ White = Image Size:
17,7M

() Advanced




image88.jpeg
AS.psd @ 66,7% (Layer 1, CMYK/8) *





image89.jpeg




image90.jpeg
Color 5.

®woww

Add 3n adjustment
i 58

| = RS8O
EEX@
Layers| Channels Paths

A B E @O THd

g A s
=

o o 3 Opacr 1008 [
Iy A 200w 7
=
-





image91.jpeg
Blending Optons.

Beve! & Emsoss.
Strake,

nner Shado.
nner Glow.
Sain.

‘Cradint Overiay

"OuterGlow.
Drop Shadon:

A0 O B G





image92.jpeg
Layer Style

Gradient Overtay

Sty et oK
D end e [ Normal () owner
 bevel & moss
opacy: w s
- Cortour -& =
e Gracint © O Reverse
sive: [ Lnear 5] & Aignwit aver & mevicn
[SE e P
D siaten wose (D)1
tner Giow =
[SE=S e K e
(] Color Overlay [ Make Defauit | [ Reset o Defauic |
S Gradenc Overay
Craemover 0 O O Gradient Editor |
— Presets s
Name: |Custom [ New |
-~ Gradient Type: | Solid |
Smoothness:[100 v | %
Stops .
Opacity: B % Location:| Delete
Color: B Delete





image93.jpeg
Pattern Over

Outer Glow

#|e7esds

Presets 2.
0rop Shade
[ save.. |
~ Name: |Custom [ New
—
Gradient Type: [ Solid ¢
Smoothness: [100 » | %
Color Picker (Stop Color)
o =
[ Cancel J
L
Add to Swatches
L )
current
[ Color Libraries |
@H: [52 ( 91
s |6 e El
O8: [o1
R [231
(] Only Web Colors G [229
Os: [216





image6.png
200px

3 100px

100px
200px





image94.jpeg
Width: [216 mm

(] From Center

Cancel





image95.jpeg
+1:00mm
£:00mm





image96.jpeg




image97.jpeg




image98.jpeg




image99.jpeg
@8 Photoshop JICH| Edit Image Layer Type Select Filter View Windc

Browse in Bridge.
Browse in Mini Bridge.
Open as Smart Object.
Open Recent

Close

Close All

Close and Go to Bridge...
Save

Save As...

Save for Web...
Generate

Place Embedded





image100.jpeg




image101.jpeg
Width: |216 mm | Height: | 100 mm|

() From Center

Cancel





image102.jpeg




image103.jpeg
@ Photoshop File Edit Image Layer Type Select Filter View Win

1 g AT N

50 © n 0

B - Rt Meke [ Selecion: MasT} sepe B
an o

" o 10 2

FUNEANNARLR]




image7.jpeg




image104.jpeg




image105.jpeg




image106.jpeg
-2

Gaussian Blur

[ cancel |

™ Preview

Radius: |6,0 | Pixels





image107.jpeg
Rayers| Channels Paths

P F @O T HO8

Normal % opacity: 100% %
W m B
[

o [l s ©
O srmarFieers

L

© Gaussantur =

o Il e |
e

o [l s &




image108.jpeg
Layers Channels Paths.

o~ )

Normai





image109.jpeg
Layers  Channels Paths

A BETE @oTHS "

o = o 18 B

tod: B 7 & @ ik 100% [
T T —

o (@5 = el
o I Smart Fiters

© Gaussanlur

-

o -

© feats

© Gradient Overtay
o Il s 8

@ fx >, .
N

B




image110.jpeg
f@meTHna

% opaciy: 100% [

<8 ik 100% [

2] =l
o [ smenries

© Gaussanslur

M Recungle 1

[~ .
=
B

| B &

#. om

B




image111.jpeg
ot | prapris S
o [T -

9.
: |

o

K 200 %

S B =
Brightness: {1 ) ‘Add an adjustment
=

Contast 10
= Al
Use Legacy Sl
A
ol

tocke BB 7 B @ i 100% 5
]

—
] ee——

oy B = -of

o l Smart Fiters

© Gussantlur

S

o o
 tes
© cmemonelr

o [l oo &

foO@wa
L 7

&





image112.jpeg
Layers

A PETEHEOT IS

o e % opsay: 1008 [%

Lock: S8 Fi 100% [+

e
Blending Options. 2 I scoroes o
Edit Adjustment...

E =
Duplicate Layer. e
Delete Layer © Gaussian Blur =
Group from Layers...

ecange 1

Layer 1

efecs
[ Gradient overtay

Background &

Create ClippingMask <. 00 ©. B 7 @




image113.jpeg
Layers | Channels _Paths

o I Smart Fiters

© Gussantlur =

© ] Rectangie1





image8.png




image114.jpeg
Layers | Channels Paths
A TPk BeTuOoa "

o o = opaciy: 100% [+





image115.jpeg
Layers
A BEmTE @O THS

o 3 opsc. 1000

ek < 8 Fil 100% [

o l Smart Fiters

© Gassanur

il

.

© Guadient Overtay

o m 3 a





image116.jpeg
o l Smart Fiters

© Gaussan tur
Iy} Recngie 1

P

@ fets

© Gradient Overtay

[ s





image117.jpeg




image118.jpeg
new

current

(L] Only Web Colors

#[a7e27 |




image119.jpeg
Layers Channels Paths.

Bind EeTnOa
Normal % opaciy: 1008 ¥
Lk B P B F 100% [

© it ¥ o

o M = ~ol

o I Smart Fiters

© Gaussaniur

M

o mari e
o
o [

= T 8
S
e
.0 O B 1

&




image120.jpeg




image121.jpeg
() From Center

[ cancel ] O





image122.jpeg
o o

Lock

el
B oo

© effeas

e
B e
[ J-n

.
Blending Optons.

[pp—
sroke.

nner Shac.
nner Glow.

Sain.

Color Overiay.
Graent Overiay.
Patern Overa.
Outer Glo.

¥_Drop Shadon.




image123.jpeg
Layer Style

Sytes

Blnding Optons: Defaut

[ Drop Shadow,
— Structure

Bend Mode: | Multly

) Bevel & Emooss
) Conteur
) Texture
ok
e Shaou
Jinner Glow,
[satin
] Color Overay
) Gradient Overay
) patern Overiay
) Guter Glow,

“0rop shasow

Opaciy

L
Distanee: 5

Spreses (5
B —

%

sooie (V)] sssiomitin

— Quality

R
Comtous| A1 0 anata

=

cec

"

o Layer Keocks 0w D

0 Shadow

[ ake Defautt | [ Reset o efaurc |

(==

[ Cancel |

[ New Style
™ Preview




image9.png




image124.jpeg
Width: (400 px | Height:

() From Center

[ oma | e




image125.jpeg
= B o o0 B
$ @ Fill: 100% %
B oo 8
o
© Do
p—
B =8
o
© Do shdow
i N coorrnn

¢ 0
i W =]

o l ‘Smart Fiers

© Gussantlur

il





image126.jpeg
Character  Paragraph »

EERSE

) e | e
. ) B e B0
I EL e o) Layers Channels _patns
v T BR . B = =
= A (PR
1T 00
A2 om ol

FETFTTTETITTT @
o @ ABRT I %

English:USA ¢ @2 ‘Stong %

registration
paymen




image127.jpeg
Character  Paragraph

Proxima Nova =
T oam  BE von B
b B [
m =
1T 100% T 0%
B o oo S

_onetime
\eruiﬁktﬂ‘aﬂ for first time

travellers

EERSE

x o

—
Dkind = e T
W I opaciy: 100K 7

. IR R B T

A 2008 [%

forfirst time.
wavelers
wsse
registraton
payment

|

Ellipse 1




image128.jpeg
Character  Paragraph

- Ry W8 Lo

PromaNova 1% Light

o x o
T e B Ese B Layers | Channels _paths
\ 0 =
= = A PG @O THR
1T 100% T om — =
e ma S = = opaciy: 100 [%

Lock @ o P
i e e ) = a

ioanmrry pu o

| (EgishUsA % % [Swong 3 o T

! © T s
© T forfimeame
© T wawlers
© T ssse




image129.jpeg
EBHEROHE

x o
Layers | Channels _paths
P F @0 T & "
T —

TTTTTTTF EME-’%Q Ak 1008
feo @ AmTI% © T maw
© T %
the world =~
© T forfirsttime
© T wavliers




image130.jpeg
A HLAR O
- xm
e =

A PETEEOTON "

T oy 0

. Lod A 100% [
i e ) Bl

rm - EEEEE

T
und the world. ... ° ; =
T

mndiheg/mﬂ@ N




image131.jpeg
i

. Tave @round the world
TREEOLEtUe nature





image132.jpeg
Place Embedded

~ | [ G2 Assets

FAVORITES
[ Work | = city=5.jpg
2 people-Lipg
people-11.jpg
[ thestory.
{5 Personal
[ nspiration
£ Mishell
{53 Google Drive
[ Documents
{1 Dropbox
© oownloads
o Applications

Name
Kind

Size
Created
Modified
Last opened
Version
Dimensions

acme-travel-log
Adobe llustrato]
16 M8

Today 17:23
Today 17:23
Today 17:23

17

Enable:| All Readable Documents &

Format:| Photoshop PDF

" image Sequence





image133.jpeg
rld
 nature .

for fiest time.




image10.png




image134.jpeg
Layer Style

Syles

Blnding Optons: Defaut

~— Drop Shadow
- stucture

Bend Mode: [ Muttply

) Bevel & Emooss
) Contour
) Texture
) swoke
e Shadou
Jtoner Glow
(satin
) Color Overisy
) Gradient Overiay
) patern Overty
) Guter Giow

I 0rop shadow

e

o (V)[BT s
E el

- Quariy

comou| 0 prttes

N =7 |x

o Laer Knocks Out Drop Shacow

[ ake Defautt | [ Reset o Defaurc |

ok

[ Cancel |

[ New Style... |
™ Preview




image135.png




image136.png




image137.png




image138.png
dl]

Pt




image139.png




image140.png
J=l




image141.png
r g
) .




image142.png




image143.png




image11.png




image144.png
A
4
) . (




image145.jpeg




image146.jpeg




image147.jpeg




image148.jpeg




image12.png
Hyphenation Disable Auto Add/Delete / Double Click To Isolate:
I OSmREIbTS Use Precise Cursors Use Japanese Grop Marks
User Interface v

o Show Tool Tips Transform Patter Tiles
File Handing & Cipboard ¥/ Ant-aliased Artwork Scale Comers
Appearance of Black Select Same Tint % Scale Strokes & Effects.

' Show "Start” Workspace When No Documents Are Open
‘Show "Recent Files” Workspace When Opening A File
Use Preview Bounds

' Append [Converted] Upon Opening Legacy Files

Reset All Warming Dialogs





image149.jpeg




image150.jpeg




image151.jpeg
nnnnnnnnnnnn




image152.jpeg




image153.jpeg




image13.png




image154.jpeg




image155.jpeg




image156.jpeg




image157.jpeg




image158.jpeg




image14.png




image159.jpeg




image160.jpeg




image161.jpeg




image162.jpeg




image163.jpeg




image164.jpeg




image165.jpeg




image166.jpeg




image167.jpeg




image168.jpeg
Attention,
LONDRES
est au
COIN
de la rue
fpli=x





image15.png




image169.jpeg




image170.jpeg




image171.jpeg




image172.jpeg




image173.jpeg
1

TTIREND  TTREND

——




image174.jpeg




image16.png




image17.jpeg
Pathfinder





image18.png




image19.jpeg




image20.jpeg




image21.jpeg




image22.jpeg




image23.png




image24.png




image25.jpeg
Pathfinder

Shape Modes:





image26.jpeg




image27.jpeg




image28.png




image29.jpeg




image30.jpeg




image31.jpeg




image32.jpeg




image33.jpeg




image34.jpeg




image35.jpeg




image36.jpeg
L]





image37.jpeg
osaiire Hasewm

Nanep]





image38.jpeg




image39.jpeg




image40.jpeg




image41.jpeg




image42.jpeg




image43.jpeg




image44.jpeg




image45.jpeg




image46.jpeg




image47.jpeg
00—





image1.png




image48.jpeg




image49.jpeg
EQ #G aNe a8 re el





image50.jpeg




image51.jpeg




image52.jpeg




image53.png
[OOSR ] - -—...-.. S ——

s ried: 1 ===
New Document Profie:  [Custom) d [ camcel ]
e GElEEE=E] = Templates...
saciog: @o28in | Rows: L
‘Size: | [Custom] B
Height: [1din Orientation: m @ b

Top

Bleed: Eoin | .)—‘.\1—” ﬁ.





image54.png
T e ¥) e ¥) e[ B (@

BE[ETmE
& wis'_no place like home.ai* @ 100% (RG/Previe

RA[0=]B~

SNE|w]ep|EN /<] H

3 51N

géb





image55.png
it

e ) s

W) oo W% [0 @) ol
. tuts+_no place like home.ai* @ 100% (RG





image56.png




image57.png




image2.png
Columns:

Raster Effects: [ High (300 ppi) -
Preview Mode: | Default &
/ Align New Objects to Pixel Grid

=)





image58.png
P MET = 5 e BIE[E] oo

1 tuts+_no place ke home.a* @ 100% RCB/Previ





image59.png




image60.png




image61.png




image62.png




image63.png
‘‘‘‘‘




image64.png




image65.png




image66.png




image67.png
#EFEAD9




image3.png
‘Guides & Grid
‘Smart Guides

Siices

Hyphenation
Plug-ins & Scratch Disks
User Interface.

GPU Performance

File Handling & Clipboard
‘Appearance of Black

Guides & Grid

Guides.

Lines k3

V Grids In Back.
 Show Pixel Grid (Above 600% Zoom)





image68.png
aaaaaa




image69.png
\1




image70.png




image71.png




image72.png




image73.png




image74.png




image75.png




image76.png




image77.png
ﬂOM E




image4.png
ST R AT AR

Guides
Smart Guides

Perspective Grid

Hide Grid Ctr

Snapto Grid Shift+Ctrl+"
Snap o Point At Ctrl+"

New View.
Edit Views.





image78.png




image79.jpeg
B ACE

ﬂOME




image80.jpeg




image81.jpeg
B
e T





image82.jpeg




image83.jpeg




